
1Product Reference Guide

Unitech PA962/PA963

Product Reference Guide

Unitech America   UTP   Unitech Europe   Unitech Greater China   Unitech Japan

www.unitech-adc.com

P/N 400424 REV.D

unitech is a member of Oracle Embedded Software 

Licensing Program 



2 Unitech PA962

Chapter 1. Introduction............................................................................ 4
Unitech PA962 & Accessories ......................................................................................... 6
Tour of the Unitech PA962 ............................................................................................... 7
PA962 Front and Left Side .............................................................................................. 7
PA962 Back .................................................................................................................... 7
First Steps with the Unitech PA962.................................................................................. 8
Installing the Battery Pack ............................................................................................... 8
Supplying Power to the PA962 ........................................................................................ 9
Charging the Main and Backup Batteries for the First Time ............................................... 9
Using the Stylus ........................................................................................................... 10
PCMCIA Pulling Tags .................................................................................................... 10
Insert CF card to PA962 ................................................................................................ 10
Protective Screen Film .................................................................................................. 11
First Operation of the Unitech PA962 ............................................................................. 11
Pressing the ON/OFF Key ............................................................................................ 11
Adjusting Screen Brightness ......................................................................................... 11
Calibrating the PA962.................................................................................................... 11
Setting Time Zone, Date, and Time ................................................................................ 11
Flash Memory ............................................................................................................... 13

Chapter 2. Using the Keypad and Scanner .......................................... 14
Keypad......................................................................................................................... 14
Alpha Key..................................................................................................................... 15
Useful hotkeys .............................................................................................................. 15
Software Keyboard (Windows CE Keyboard) .................................................................. 16
Opening the Windows CE Keyboard: ............................................................................. 16
Keying-in Characters: .................................................................................................... 16
International Character Support: ..................................................................................... 16
Moving the Keyboard: .................................................................................................... 16
Closing the Keyboard: ................................................................................................... 16
Using the Laser Scanner ............................................................................................... 17

Chapter 3. Power system.........................................................................18
Charging the Lithium-Ion Battery Pack ........................................................................... 18
Charging the Main and Backup Battery for the First Time ................................................ 18
Power Status Indication ................................................................................................ 19



3Product Reference Guide

Checking Main and Backup Battery Status .................................................................... 20
How to Save Battery Power ........................................................................................... 21
Warm Boot / Cold Boot ................................................................................................. 22
Charging Considerations ............................................................................................... 23
Storage and Safety Precautions .................................................................................... 23

Chapter 4. Communication .....................................................................24
Introduction ................................................................................................................... 24
Connecting ................................................................................................................... 24
ActiveSync ................................................................................................................... 25
Installing Microsoft ActiveSync ...................................................................................... 25
Connecting the Device to your computer......................................................................28
Synchronizing with your computer............................................................................... 30
Synchronizing Information ...........................................................................................32
Use Activesync to exchange files ................................................................................ 33

InBox............................................................................................................................ 34
Sending and Receiving E-Mail with InBox ....................................................................... 34
Sending Mail Remotely ................................................................................................. 34
Setting Up Remote Mail ................................................................................................ 35
Work Remotely ............................................................................................................. 35
Receiving Messages ..................................................................................................... 36
Sending Messages ...................................................................................................... 37
RF Communication ....................................................................................................... 37
Setting the RF communication............................................... ...................................................38

Chapter 5. Useful Application Program.................................................. 40
Scanner Setting ............................................................................................................ 40

Appendix A ................................................................................................................... 42
Appendix B ................................................................................................................... 46
Update OS via Compact Flash (ATA card) ....................................................................... 46

Appendix C ................................................................................................................... 48



4 Unitech PA962

Chapter 1. Introduction

Thank you for purchasing PA962.

PA962 is a rugged, compact and lightweight palm-size computer. It
utilizes the Windows CE6 operating system, and incorporates an integral bar
code scanning laser device, color LCD with touch screen, keypad, IrDA
interface, and wireless communication capability.  It provides the user with a
standard Windows-based environment for customizing and operating the
device.
This PA962 product reference guide will guide you to access your PA962.

Unitech PA962
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NOTICE
This unit is equipped with a battery pack and backup battery. It is possible that the Unitech
PA962 may not powered on due to battery discharge as a result of storage.

In the above situation, plug the PA962 to the RS232 or USB cable with DC in port or
put the unit into the Unitech PA960/PA962 Cradle (with 12V/2AAC-DC adapter), and recharge
the unit for 16 hours in order to fully charge its backup battery.

The backup battery will charge from external power or the main battery (if the main battery still
has enough power to turn on). In the event the main battery is fully charged, refrain from using
the PA962 for 16 hours in order for the main battery to fully charge the backup battery.

Backing up data by backup battery only, without the main battery installed in battery compart-
ment may take as long as 6 hours. Therefore, in order to prevent data protection failure due to
backup battery failure, do not leave the PA962 without the rechargeable battery pack installed,
or without connection to AC power for an extended period of time.
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Unitech PA962 & Accessories

After opening the box, please make sure the
following accessories for the PA962 are present:

Stylus

Pulling-tags RF Card Cushion

Unitech PA962
Quick Reference

Guide

PA962 CD

PA962 Main Body

Battery pack

CF slot drawer for
PA962
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Tour of the Unitech PA962

PA962 Back View

PCMCIA compartment
Install PC card here.

Battery compartment
Install Lithium-ion battery
pack here.

IrDA port

Reset Hole
Push enclosed button
for system warm-start

Keypad

Stylus
This stylus is designed for tapping screen
and also for accessing battery door

Bar Code Laser Scanner

LED Indicator for scanning
good and charging indica-
tion

Touch Screen

Right Side Scanner
Trigger
Press it to enable laser scanner
to read bar code.

RS232/USB/Charging Port

CF slot compartment
Please remove the battery
door to access CF slot.
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First Steps with the Unitech PA962

There are three ways to provide power to the PA962:

NOTE: Data you enteredmay not be properly stored until the built-in backup battery
has been adequately charged. Please remember to turn on the backup battery
before you charge the terminal.

Installing the Battery Pack

Remove the battery compartment door
(located on the lower back side of the
unit).

Position the battery pack with the label side towards you
and the battery pack strap towards the bottom of the unit.
Insert and fully seat the battery pack, making sure the
shape of the battery pack fits the shape of the battery
compartment.

Docking Station�

RS232/Charging cable or USB/Charging cable�

Rechargeable Lithium-Ion battery pack�

1.

2.
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Or place the PA962 into the Docking
Station (first connect the power supply
to the Docking Station).

Connect the RS232/Charging Cable or USB/
Charging Cable to the PA962, and then connect
the AC adapter to the cable’s power jack and an
electrical outlet.

Supplying Power to the PA962

3.
Position the battery pack and install the battery
compartment door.

Charging the Main and Backup Batteries for the First Time

It may take up to 16 hours to fully charge the empty backup battery. The first time
charge should be at least 16 hours to ensure a proper charge.

CAUTION: Operating the PA962 for the first time without the AC adapter,
and without fully charging the backup battery may result in loss of data
stored in RAM memory.
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If a PCMCIA card is inserted into the PA962 without
previously attaching a Pulling Tag, the card can be
removed by affixing a length of adhesive tape to the
surface of the card and pulling the card out by pulling
outward on the piece of tape.

PCMCIA Pulling Tags

Pulling Tags simplify the removal of PCMCIA cards from the
PA962. Before inserting a PCMCIA card, remove one of the
three Pulling Tags from the Pulling Tag sheet and adhere it to
both sides of the PCMCIA card, leaving a short (approx. 89) tab.
To remove the PCMCIA card, simply pull outward on this tab.

Using the Stylus

CAUTION: Never use anything other than the PA962's stylus on the
screen. Using object other than a stylus could cause permanent
damage.

To write data into a field on a form, use the stylus to print the letters
or numbers. Use very light pressure.

3.

To make a choice from a menu, lightly tap the tip of the stylus on
that choice.

2.

Hold the stylus as you hold a pencil.1.

Front side of PCMCIA cardInsert CF card to PA962

Find the CF drawer from PA962 package, insert CF card to the
CF drawer. Then insert the CF drawer to the PA962 and place
the CF slot door. Re-install the battery door to PA962 with screw
driver of PA962 stylus.

1. 32.

Your CF card
CF Drawer
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First Operation of the Unitech PA962

Pressing the ON/OFF Key

The Unitech PA962 welcome screen appears. The
Windows CE® screen will appear shortly.

Adjusting Screen Brightness

Press [FUNC] key and Cursor key to decrease
or increase screen brightness.

Calibrating the PA962

The PA962 will prompt you to calibrate the unit by
tapping a sequence of screen locations. Tap
gently but firmly. When you have completed the
series of taps, press the [ENT] key to confirm it or
press the [ESC] key to cancel it.

This screen will automatically appear when the
unit is powered-on for the first time or after the
system is reset. This screen can also be ac-
cessed at any time by pressing the hot key
[FUNC] and the [ESC] key.

Setting Time Zone, Date, and Time

After Calibrating the PA962, the “Date/Time Prop-
erties” dialog box will appear. Follow the steps
below to set the date and time.

Protective Screen Film

The PA962 screen ships with a protective plastic film. You may remove this if
desired by peeling from one corner. The screen will be more susceptible to
scratching without the film, but will be more readable.
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Setting the Time Zone first

Setting Year and Month

Follow the steps below to set up your time zone.

1. Tap the location arrow to see a list of cities.
2. Choose your location (or nearest listed one).
3. Select the Daylight Savings Time check box, if necessary.
4. Tap the APPLY button.

Tap the Left or Right arrows to scroll the month.

Or directly tap location of year or month to change the year or month setting.

Exiting Date/Time Properties Settings
Tap OK or X (cancel) button at upper-right corner to exit.

Tap here to
directly
change

year setting

Tap here to
popup list
of months
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Flash Memory

To save to Flash Storage, select File, Save To, and
select Flash Storage .

Flash Memory is a re-writable location for programs and
data files. The benefit of this feature is that files and
programs saved in Flash Memory are unaffected by the
PA962's power status.

To access the contents of Flash Memory, simply select
:My Computer on the desktop and then select :Flash
Storage.. The programs and data files currently stored
in Flash Memory will be displayed.
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Chapter 2. Using the Keypad and Scanner
Keypad

The PA962 series keypad contains 19 keys, including Cursor key, 0~9, Alpha key,
ON/OFF, Function, Escape, Backspace, and Enter key. Please refer to the
picture below.

[ENT] The Enter key is used to initiate a process or confirm a selection
made by the user.

[TAB] The Tab key is used to toggle between data fields or to place the
cursor at pre-determined places in a programming or word pro-
cessing application.

[FUNC] The Function key is used to perform alternative key functions.

[ Back space] The Backspace key is used to erase previously input characters.

[ESC] The Escape key will perform the same function as tapping the
CANCEL button or the X button on the touch screen.

ON/OFF When the unit is off, pressing the On/OFF key will turn the unit on.
Alternatively, when the unit is on, this key must be pressed and
held down for about two seconds in order to turn the unit off.

[Alpha] This Alpha key is used to toggle between Numberic & Alpha Mode.
This Apha key is also used to toggle CAPS at Alpha Mode.

Backspace

Power On/Off

TAB
Function

[Cursor] This Cursor key is used to navigate among applications.

Alpha

Cursor
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Useful hotkeys

The PA962 provides eight combination hot keys to activate specified screen
setting functions or programs. These hotkeys are useful for calibrating the touch
screen, toggling the backlight, and adjusting screen contrast when the menu-
driven operation is disabled. Below is the list of hotkeys. To use them, press and
hold the [FUNC] key in combination with the corresponding second key.

[FUNC] + [ Decrease screen brightness.

[FUNC] + [7] Scanner Setting.exe
[FUNC] + [6] Task manager
[FUNC] + [TAB*] Toggle screen & LCD backlight.
[FUNC] + [
]

Increase screen brightness.

[FUNC] + [ESC] Check Stylus properties & Re-Calibrate the PA962’s touch screen.

[FUNC] + [8] Power Properties
[FUNC] + [9] System Information

[FUNC] + [Cursor] Use Function key & Cursor “UP” to Toggle Display Backlight

Alpha Key

Alpha Mode Press alpha to alpha mode, the default condition is CAPS off.
CAPS Press Apaha key twice to toggle CAPS

When the PA962 boots, the default condition is Numeric Mode on. When you
toggle to Aphal Mode, the default condition is CAPS mode off.

                                       [FUNC] + [0] Space

                                      [FUNC] + [Cursor] Use Function key & Cursor “Down” to Toggle Keypad LED Backlight
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Keying-in Characters:
After tapping the “keyboard” icon, the Windows CE keyboard pops up. Character
input is the same as on a standard PC. Simply tap the on-screen button corre-
sponding to the character you want to input.

Software Keyboard (Windows CE Keyboard)

Since the PA962’s keypad allows input of numeric characters only, the Windows
CE Software provides a touch screen keyboard for input of other characters. The
Windows based keyboard replicates the layout of a standard PC keyboard.

Closing the Keyboard:
Tap the keyboard icon to close the Windows CE keyboard.

Moving the Keyboard:
Use the stylus to point to the title bar (the bar displaying
“Input panel”) and then move the stylus without lifting it
from the screen.

International Character Support:
Tap the [áü] button to switch from the standard English
keyboard to the European keyboard.

Opening the Windows CE Keyboard:
The Windows CE keyboard can be opened by tapping the “keyboard” icon on the
task bar. (Refer to picture).

Double-tap here

Title Bar
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Using the Laser Scanner
Note: Reading software must be enabled in order to operate the scanner. This
can be a user-loaded application or a pre-loaded utility such as Scanner Setting.
exe.

The PA962 has an integrated laser scanner,
which reads all major bar code labels with
excellent performance.

Trigger keys are located on the left and right
sides of the unit. Press either one to activate
the laser scanner.

The PA962 also has a built-in Scanner Setting.exe
program that allows the user to test the
barcode scan function. Scanner Setting.exe is
located in directory \Windows\Control and is
also accessible by shortcut via
“Setting\Control” on the Start menu.

Laser Scanner

Left
side
trigger

Right
side
trigger
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Chapter 3. Power system

Note: Backing up data by backup battery only, without the main battery installed
in the battery compartment may take as long as 6 hours. Therefore, in order to
prevent data protection failure due to backup battery failure, do not leave the
PA962 without the rechargeable battery pack installed, or without connection to
AC power for an extended period of time.

It may take up to 72 hours to backup data when the PA962 is automatically shut
down because of very low battery power while the depleted batteries are still
installed in the battery compartment.

Note: Before using the PA962 for the first time, charge the unit for 16 hours to
fully charge the empty backup battery. Operating the PA962 for the first time
without the AC adapter, and without fully charging the backup battery may result in
loss of data stored in RAM memory.

Charging the Main and Backup Battery for the First Time

Charging the Lithium-Ion Battery Pack

The optional Docking Station is a convenient accessory for daily use of the PA962.
The charging will be completed within 3 hours. Or, when using the included
Charging/RS232 Cable or Charging / USB cable the charging time of the battery
pack is about 3 hours.
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“Backup Battery Very Low” icon: When
displayed indicates the backup battery is
very low. Stopping the operation and charg-
ing the PA962 immediately is highly
recommended.

“Battery Very Low” icon: When displayed
indicates the battery is very low. Stopping the
operation and charging the PA962 immedi-
ately is highly recommended.

“Battery Low” icon: When displayed,
indicates the battery is low and needs to be
charged.  In other words, there is no external
power supply, the battery charge is low or
very low, and charging the PA962
is recommended.

Power Status Indication

Four different icons are displayed on the status bar to indicate the on-board power
status.

“Backup Battery Low” icon: When
displayed indicates the backup battery is low
and needs to be charged.

Backup Battery Low

“Plug” icon: When displayed, this icon
indicates that the battery is charging. The
PA962 is either plugged-in via the DC
12V/2A power adapter or in the docking
station.

Plug with power adapter

Battery Low

Battery Very Low

Backup Battery Very Low or Backup
Battery is not turned on.

No icon: When displayed means there is
no external power supply to the PA962 but
its battery power status is good.
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Checking Main and Backup Battery Status

Enter “Power Properties”:

If the above mentioned “Plug” icon or “Battery” icon is
displayed, double tap this icon to bring up the “Power
Properties” screen.

Or, select Settings/Control Panel from the Start menu
and then double tap the “Power” icon to display “Power
Properties”.

Check Battery Status:

It is necessary to charge the battery when “Low” or “Very
Low” are displayed in bold characters. If “Low” or “Very
Low” are still displayed after charging, please contact
Unitech Technical Support.

The battery menu item will show the status of the main
and backup batteries. There are 3 kinds of status indica-
tors — “Good”, “Low” and “Very Low”. Bold characters
indicate the actual status, e.g. battery icons in the illustra-
tion at right mean both the main and backup batteries are
“GOOD”.
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Tap the “Backlight” menu item to display the following 3 selections:

How to Save Battery Power

Because the power consumption of the LCD backlight is
high, turn off the backlight function if it is not necessary.
If a backlight is required, set “automatically turn off the
back-light” function.

To change backlight settings, select Settings / Control
Panel from the Start menu, and then double tap the “Dis-
play” icon.

Backlight Setting

Automatic shut-down of the PA962

The PA962 will enter idle mode when there is no task, or all tasks are waiting for
input. In default setting, the PA962 will automatically turn itself off if it remains idle
for 3 minutes and when there is no external charging power applied. Pressing the
power button will return the PA962 to the same point at the time of automatic
shutdown.

This function can also be activated when the PA962 is
plugged into the power adapter or placed in its cradle by
tapping the check box and then tapping the arrow to select
from a list of time periods. The available time periods are
1, 2, 5,10, 15 and 30 minutes.

In Power Properties, select “Power Off”. Customize
automatic shut off time by tapping the arrow to select from
a list of time periods. The available time periods are 1, 2,
3, 4, and 5 minutes.
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WarmBoot / Cold Boot

Tap the check box to toggle this function. Available idle
times are: 15 and 30 seconds, and 1, 2, and 5 minutes.

Automatically turn off the backlight when using
battery power:

Automatically turn off the backlight when using
external power:

Tap the check box to toggle this function. Available idle
times are: 15 and 30 seconds, and 1, 2, 5, 10, 15, and 30
minutes.

Automatically turn on the backlight when key

This function is only activated by the PA962’s keypad
rather than the Windows CE keyboard.

Cold Boot

Press the coldboot buttom underneith the
PCMCIA cover, the terminal will perofrm coldboot.

NOTE: Cold Boot will cause the PA962 to
return to its original factory settings.

Warm Boot

WARNING: Warm Boot will cause unsaved data to be lost.

To perform a warm boot while the PA962 is operating, insert a pin (paper clip
works well) into the reset hole on the back of the terminal, right below the
PCMCIA cover.

�

Under the Windows folder of your terminal, locate the file BootMode.exe,
execute the program, and confirm the warning message.

�
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Storage and Safety Precautions

Although charged Lithium-Ion batteries may be left unused for several months,
their capacity may be depleted due to build up of internal resistance. If this hap-
pens they will require recharging prior to use. Lithium-Ion batteries may be stored
at temperatures between-20°C to 60°C, however they may be depleted more
rapidly at the high end of this range. It is recommended to store batteries within
normal room temperature ranges.

Charging Considerations

It is important to consider the environment temperature whenever you are charg-
ing the Lithium-Ion battery pack. The process is most efficient at normal room
temperature or slightly cooler. It is essential that you charge batteries within the
stated range of -5°C to 50°C. Charging batteries outside of the specified range
could damage the batteries and shorten their charging life cycle.
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Chapter 4. Communication

Connecting

Introduction

The Unitech PA962 allows users to link to a host computer via RS-232,USB, IrDA,
or RF connection for data communication.

This chapter provides an overview of the communication of the PA962. The
following subchapters cover these topics:

“RF Communication” for details about wireless communication between
mobile PA962 and host computers.

�

”Microsoft ActiveSync” for details about serial communication via RS232/ USB
port.

�

Docking Station

Plug the RS232 end of the communication cable to
the PC’s 9 pin Com Port and the other end into the
Cradle’s RS232 Port. Plug the Power Supply into
the Power Receptacle on the Docking Station.

Serial or USB Cable

Plug the RS232 or USB end of the communication
cable to the PC’s 9 pin Com Port and the other into
the PA962 RS232/USB/Charging Port (see page 3).
Plug the Power Supply into the Power Receptacle
on the RS232 or USB plug.
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ActiveSync

In order to exchange data between your desktop computer and the PA962,
Microsoft ActiveSync must be installed on your desktop computer.

This chapter will introduce Microsoft ActiveSync version 4.2. ActiveSync provides
a user-friendly interface and it can be downloaded free of charge from Microsoft’s
Web site.

With Microsoft ActiveSync you can:

Add programs to and remove programs from the PA962.�

Transfer data.�

Back up and restore PA962 data.�

Installing Microsoft ActiveSync

Before beginning installation, carefully read the following:

If you run the Windows NT® operating system with a service pack, you will be
informed during setup that you may need to reinstall the service pack. Try
connecting first, and if unsuccessful, reinstall the latest service pack.

�

To set up your communication settings, a PA962 serial cable is required to
connect the PA962 to your host computer.

�

Because you will be restarting your computer during installation, save your
work and quit all programs before you begin.

�

Installation

Follow the installation procedure below to install Microsoft ActiveSync, connect
your PA962 to your desktop computer, and establish a partnership for synchroni-
zation (if desired):
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Download the ActiveSync software
from the Microsoft web site at:
http://www.microsoft.com/
windowsmobile/downloads/
activesync42.mspx
The installation wizard begins.

�

�

� Accept the license agreement
terms and click Next.You are 
prompted for user information.

Click Next. You are prompt to read the
End User Licensing Agreement(EULA).
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Type the user's name and organization
and click "Next". You are prompted for
destination folder.

�

�

 

6 Select a drive to install the
program and click Next.The
installation wizard has gathered
the information it needs to install
Activesync and prompts you
to begin the installation.

Click Install. The program begins
the Installation.
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� When the configuration process is
complete, you’ll see the following
screen:

Click the Next button and follow the instructions to set up a partnership between
the PA962 and your desktop computer.

This partnership allows you to synchronize information between the two
computers.

� Different PA962 cannot share the
same Device Name if more than
one terminal is to be connected to
the same PC via a “Partnership”.
The default Device Name assigned
to the PA962 is “WinCE”.
It is important to specify a different
name for each terminal if more than
one terminal is to be connected to
the same PC. When ActiveSync
displays the following screen,
assign each terminal its own
unique name.

Synchronization will be initialized and will take place if you’ve chosen to synchro-
nize periodically or upon connection.

Note: Your desktop computer can create a partnership with multiple PA962. Also,
a PA962 can create a partnership with up to two desktop computers.

After the program has finished
installing you will see the following
screen.

Click Finish. You may be prompted to restart your computer.
After you have installed ActiveSync and restarted your computer, the ActiveSync icon appears on
your computer's desktop.

Connecting the Device to Your Computer
1. After Activesync has been installed, connect the USB charging cable to the universal
connector on the bottom of your device.
2. Plug the other end of the USB charging cable into a USB port on your computer.
3. Turn the device on.
4. Activesync starts automatically and configure the USB port to work with the PA962.The New
Partnership setup wizard will automatically start.

Note: If Activesync does not start automatically, click Start > Programs > Microsoft Activesync. If a
message appears indicating that it is unable to detect a connection, click the Cancel button and
manually configure the communication settngs.
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In the displayed window, you can:

� Select your PA962 to use Microsoft
ActiveSync features such
as changing synchronization
options, as described in the “Syn-
chronization” section.

Use this window, which is the root
window to the PA962, to copy and
move files between the PA962 and
your desktop computer, as de-
scribed in the “Synchronization”
section.

Open the Explorer window by
double-clicking your device icon in
the Mobile Devices window.

�

Using the Mobile Devices Window

Start Microsoft ActiveSync by clicking
the Microsoft ActiveSync shortcut on
your desktop and then clicking the
“Explore” icon.

5. Follow the onscreen instruction.
6. When the configuration process is
complete, the Activesync window will
appears.

7. Synchronization will be initialized and will take place if you have chosen to synchronize
periodically or upon connection.

Note: Your computer can create a partnership with multiple PA962s. Also, a PA962 can
create a partnership with up to two computers.
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Changing Communications Settings

If Microsoft ActiveSync fails to detect the PA962 during installation, set up commu-
nications manually instead. Make sure the following conditions are met:

To check communications settings,
open the Mobile Devices folder, and
click File => Connection Settings.

The baud rate on the PA962 is set to
57600bps by default. To adjust the
baud rate, tap Start, Settings, Con-
trol Panel, select the Communication
icon, select the PC Connection Tab,
and then tap the “Change
Connection….” Button. For more
information, see Microsoft ActiveSync
Help.

� Set your baud rate on the PA962 and desktop computer will match it.

� Microsoft ActiveSync uses the specified communication ports to connect to
the PA962. Make sure these resources are available for Microsoft ActiveSync
to connect to the PA962. Other programs cannot use them while the PA962
and your desktop computer are connected.

� Verify that the correct communications port is selected for your desktop
computer, and that it is free.

Synchronizing with your computer

Synchronization takes place according to the options you choose while setting
upActivesync on your computer. If you accept the default (On Connect) synchronization
option in the Microsoft ActiveSync Setup Wizard, you'll be able to simply connect
Your PA962 to your desktop computer and synchronization will take place.

If you have not enabled the On Connect feature in ActiveSync, you can start
ActiveSync in either of the following ways:

On your computer, double click My computer > Mobile Devices folder.
Connect the USB cable between the computer and PA962.

Connection options

You can set remote synchronization with your computer using the following
connection options:
- USB connection
- Infrared connection
- Bluetooth connection
-WiFi connection

USB Connection
To synchronize with your computer using a USB connection:

1. Connect your device to your computer using the USB charging cable.
2. Initiate connection by tapping Start > Settings > Control Panel > PC connection.
3. Select Enable direct connections to the desktop computer using this check box.
4. Tap OK.
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Synchronization
You can synchronize information between the PA962 and your desktop computer
to insure both computers have current information. First you’ll need to install
Microsoft ActiveSync on your desktop computer.

Synchronization takes place according to the options you chose during Microsoft
ActiveSync setup.  If you accept the default (On Connect) synchronization option
in the Microsoft ActiveSync Setup Wizard, you’ll be able to simply connect your
PA960 to your desktop computer, and synchronization will take place.

If you have not enabled On Connect, start Microsoft ActiveSync in either of the
following ways:

If you want to change the terminal’s default baud rate or
use IrDA to communicate with the Host PC, follow the
steps below to adjust it:

Select the baud rate from the list box.4.
Tap the Change Connection button3.
Tap the PC Connection tab.2.

Tap Start, Settings, Control Panel, Communica-
tions

1.

On your desktop computer, double-click the My Computer
icon and then double-click the Mobile Devices folder.

�

Plug the RS232 cable or USB cable between the PC and the
PA962.

�

Execute “Repllog.exe” from the PA962’s Windows directory
(if ActiveSync is setup to sync using the IrDA port on both PC
and PA962).

�

To turn on IrDA:
1. Click on the “Control Panel” icon on your PA962
2. Double-click the “Communication” icon
3. Click the “PC Connection” tab
4. Tap the “Change Connection” button
5. Select IrDA.

Infrared Connection

The infrared port allows you to synchronize
information with an infrared enabled computer. Align
the infrared port of your device with the infrared port
on the computer. This method is ideal for quickly
switching between multiple
devices since there are no cables or adapters to
change.

1. Perform the steps below on your computer:
a. Configure an infrared port on your computer
following the manufacturer's instructions.
b. Once your computer's IR port is ready, open
ActiveSync.
c. Click File > Connection Settings.

d.Check Allow connections to one
of the following and select Infrared
Port (IR) from the drop-down list.

e. Click OK.
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After you’ve synchronized, you’ll see the status message in the status bar of the
Mobile Devices windows. At any time, you can check the status. Click the Tools
menu, and click ActiveSync Status to display the ActiveSync Status window.

Synchronization may take a few minutes,
as each item to be synchronized needs to
be processed. You’ll see a message
indicating that synchronization is taking
place.

Synchronization will take place according
to options you’ve chosen. To initiate
synchronization manually, click Tools, and
then Synchronize Now.

Files

All files you create on the PA962 are stored in a My Document/PA962 My Docu-
ments folder (if the assigned Device Name is PA962). View those files by double-
clicking the short-cut PA962 My Documents icon on your desktop computer.

If you have enabled file synchronization, your PA962 files are automatically syn-
chronized on your desktop computer file folder WinCE_PC My Documents -
unless a different name was chosen for the PA962. This folder can be found in
one of following locations:

During synchronization, files are copied back and forth between the PA962 and
the desktop computer.

Windows NT:WINNT\Profiles\your user-name\Personal\WinCE_PC My
Documents.

�

Windows 95/98: My Documents\WinCE_PC My Documents.�

What Gets Synchronized

The following sections provide an overview of how various types of information
are synchronized. For details on synchronizing specific items, see Microsoft
ActiveSync Help.

2. Perform the steps below on your device:
a. Align the IR port of your PA962 with the IR
port on your computer so that they are
unblocked and within close range.
b. Initiate connection by tapping Start >
Settings > Control Panel > PC Connection.
c. Select Enable direct connections to the
desktop computer using this check box.
d. Tap the Change Connection.
e. Select IrDA.
f. Tap OK.
g. Tap My Device > Windows > Repllog.exe

Bluetooth Connection
For details of bluetooth connection, please refer to the Utility Manual.

Synchronizing Information

All files created on the device are stored in PA962 > My Document folder
(if the designated device name is PA962). You can view files by double clicking the
PA962 > My Documents icon on your computer.
If you have enabled file synchronization, your PA962 files are automatically
synchronized in the My Document folder on your computer, unless a different
name was chosen for PA962.

Synchronization Options
Synchronization options can be modified, including when you synchronize and what
gets synchronized. In the Mobile Device window, click Tools > Sync Options.
For each type of information, the synchronization process can be hastened by
limiting the amount of data to be synchronized. To do this, select a service and click
the Settings button. After enabling a service, you must close and reopen the
ActiveSync.
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Installing and Removing Software

Changing Synchronization Options

Synchronization options can be
modified, including when you synchro-
nize and what gets synchronized. In
the Mobile Device window, click Tools,
and then Sync Options.

For each type of information, the
synchronization process can be
hastened by limiting the amount of data
to be synchronized. To do this, select
a service and click the Settings
button.

Any program created for your PA962 can be installed as long as there is sufficient
memory or storage space.

First install the software on your desktop computer and then connect the PA962 to
your desktop computer. Some software programs provide their own setup
instructions. Most software programs use Application Manager to install and
remove software on the PA962. In the Mobile Device window, click Tools, and
then click Application Manager.

After enabling a service, you must close and reopen the ActiveSync
Options dialog box before the Option button is available for that service.

�

Note: The PA962 only supports File synchronization.  Inbox, channels, and
Tasks are not supported.

�

Inbox, Tasks, and
Channels not supported

Using ActiveSync to Exchange Files
You can use activesync to exchange information from your device to your computer
and vice versa. changes you made to the information on one location will not affect
the information on the other one. if you want to automatically update information on
both your device and computer, synchronize the information instead.
You can copy two types of information to your device: files and Pocket Access
Windows CE Store information.
The procedure below only applies to copying files. Refer to the ActiveSync Help on your
computer for instructions on how to copy Pocket Access Windows CE store
Information.
Note: Files created on your computer may need to be converted by ActiveSync

So that they can be viewed and edited on your device, and vice versa.

To copy files:
1. Connect your device to your
Computer.
2. In ActiveSync on your computer,
Click Explore.
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Application Manager detects the software
that is available but not yet installed on the
PA962.

System software and programs added to
the PA960 at the factory are stored in
FlashROM. You cannot remove or modify
this software, and you’ll never accidentally
lose FlashROM contents.

Software programs and data files added to
your PA962 after factory installation can be
stored in RAM or Flash Memory.

InBox

Following is an overview of InBox. Step-by-Step information on how to use this
program can be found in the Help function on the PA962. To view Help, tap Start,
and then Help.

Sending Mail Remotely

In addition to exchanging mail messages with your desktop computer, you can
send and receive mail from a remote mail server by setting up an e-mail account
with a service provider.

Sending and Receiving E-Mail with InBox

Use InBox to send and receive e-mail messages using any of these methods:

Send and receive messages using a wireless network card to a local area
network (LAN).

�

Send and receive messages using a dial-up connection to a service provider
or your corporate network.

�

Note: You can send and receive messages with Inbox, but this function cannot
be synchronized with Outlook.

Windows Explorer opens the Mobile Device window for your device.
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Note: If you’re setting up an Internet mail account with an ISP (Internet Service
Provider), the ISP must use a POP3 mail server and an SMTP mail gateway.

For dial-up connections, you’ll require an internal PCMCIA type modem card or
external modem for the PA962. You’ll also need to set up the remote connection
on the PA962 using the Connections program.

For wireless connections, you’ll require a RF card for the PA962. You’ll also
need to set up the remote connection on the PA962 via the Network setting.

The software for creating an Internet Mail connection to an ISP is pre-installed on
the PA962.

Setting Up Remote Mail

You can use multiple mail ser-
vices to obtain mail. For each
mail service you will access, first
set up and name each mail
service. If you will use the same
service to connect to different
mailboxes, set up and name each
mailbox connection.

In the InBox on the PA962, tap
Compose, Options, the Ser-
vices tab, and then the Add
button. A setup wizard will walk
you through the steps.

Work Remotely

Mail received via dial-up connection appears in the InBox folder on the PA962,
together with the mail you synchronize with your desktop computer. Messages
received remotely are linked to your mail server rather than to your desktop
computer.

You can work online, which means that you read and respond to messages while
connected to the server. Messages are sent as soon as you tap Send, which
saves space on your device.
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You can also work offline. Once you’ve downloaded new message headers or
partial messages, you can disconnect from the server and then decide which
message to download completely. The next time you connect, InBox automati-
cally downloads the complete messages you’ve marked for retrieval and sends
the messages you’ve composed.

Receiving Messages

Messages received by synchronizing with your desktop computer and through
remote connections appear together in your InBox. Double-tap a message to read
it.

When you connect to your Internet mail service, the InBox downloads only the first
100 lines of each new message to the InBox folder by default. No mail attach-
ments are downloaded. When you synchronize with your desktop computer, only
the first 50 lines of each new message remains on the mail server or your desk-
top computer.

You’ll need to download a full message before you can view its attachments.

You can mark the messages that you want to retrieve in
their entirety the next time you synchronize or connect to
your mail service. Select the message, tap Service, and
then tap Retrieve Full Copy. The icons in the InBox
messages list give you a visual indication of the message
status.

Specify your downloading preferences when setting up
the service or selecting your synchronization options.
You can change them at any time.

� To change InBox delivery options for mail synchronization: in the Mobile
Devices window on your desktop computer select your WinCE icon, click
Tools, and then click ActiveSync Options. Select Message and then click
Options. (For the Options button to be available, you must have previously
enabled message synchronization.)

� To change InBox delivery options for remote mail: in InBox on your PA962, tap
Service and then tap the service name. Then tap Service again and tap
Properties.
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To send your message, tap File and Send. Messages are placed in your OutBox
folder on the PA962 and will be delivered to their destination in one of two ways:

Sending Messages

To compose a new message, tap the New Message button on the command bar.
Enter an e-mail address in the To field or select a name from the Address Book.
All e-mail addresses entered in the e-mail fields in Contacts appear in the Address
Book.

� They are transmitted to your mail server the next time you connect remotely.
In InBox, make sure the appropriate service is selected on the Service menu.
Then tap Connect.

� They are transferred to the OutBox folder in Exchange or Outlook on your
desktop computer the next time you synchronize.

RF Communication

Windows CE can support TCP/IP protocol, so the user can easily connect to the
Internet by Modem or RF. The following chapter is an introduction on how to
connect the PA962 to a network via TCP/IP.

There are several PCMCIA RF cards available on the market. These cards
provide the PA962 with wireless communications. Currently, Unitech provides
Cisco 350, Agere (Lucent OEM 802.11b card) support for the PA962 with the
drivers pre-installed. By selecting a supported card for the PA962 RF communi-
cation will be “plug-and-play”.

RF networks look and operate similarly to Ethernet networks. The only differ-
ence is that a radio transmission replaces the hard-wire connection between
the various nodes. This means all of your existing applications that currently
operate over Ethernet will also function utilizing WLAN without any special
wireless network software. This picture illustrates a typical network topology
including the PA962 with RF.

WMS Database

Hub

WMS Database

Hub

PA962 come with a built-in RF card. The driver and the utility are also
built in the firmware.
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Installing the Wireless Local Area Network (WLAN) Card

RF Card Cushion

Remove the protective backing from the sticky side of the RF Card Cushion and
install the cushion along the inside upper edge of the PCMCIA Cover as shown.
The RF Card Cushion prevents damage to the RF card antenna in case the
PA962 is accidentally dropped.

Re-attach cover to the PA962

Setting Up the Wireless Card

The PA962 is pre-loaded with connection software from
Cisco and Lucent WaveLAN (Agere Orinoco). The PA962
will automatically detect these RF cards and then display
the following screen during the first-time installation.
Please note that there are two ways to set the IP
address:

Insert the RF card into the PCMCIA slot.�

� Attach pulling-tag to antenna.

Remove the stylus, using the screw driver
in the stylus to remove the screw, and
then open the PCMCIA compartment.

�

Power off the PA962.�

� Attach the snap-on antenna to the RF card
if required (only the Cisco card comes
with a pre-installed antenna).

PCMCIA card
front side
PCMCIA card
front side

Setting the RF Communication

1. Double tap Summit Client Utility.

2. Under “Main” tab, for Active
Profile, select “ThirdPartyConfig”.
Tap “OK”.
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To avoid conflict with your LAN environment, please consult with your MIS depart-
ment for the correct TCP/IP setting.

If there is no DHCP server in your LAN environment, specify the individual IP
address on each PA962 with the following steps:

Specifying an IP Address

Obtaining an IP Address via DHCP Server

Please check with your MIS department to determine whether a DHCP server is
available in your LAN environment.  If available, tap the radio button Obtain an IP
address via DHCP, and then tap the OK button.

Tap the Name Servers tab,
and then input the proper
Primary DNS, Secondary
DNS, Primary WINS, and
Secondary WINS.

�

Input the proper IP address,
Subnet Mask, and Default
Gateway.

�

Tap the radio button Specify
IP Address.

�

Note : To change the above settings, please perform the following steps:

Select the proper RF
card driver and then
tap the Properties
button.

�

Double tap the Net-
work icon.

�

Tap Start, Control
Panel.

�

3. Warm Start the terminal. Once
the terminal is warm started, the RF
card is detected. You will see the
RF setting window pop up. Tap
“Add New”.

4. Enter the SSID. Uncheck “The
key is provided automatically”.
Enter the network key. Tap “OK”.

5. Start to search for RF signal and RF is connected.
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Chapter 5. Useful Application Program

Scanner Setting

When it is necessary for the user to change the default barcode symbology for a
different application, Scanner Control Panel provides the ability to change default
symbology, place delimiter characters behind scanned data, and save the
settings.
Run this program from \Windows\Scanner Setting.exe and Scanner Control
Panel will be displayed.

Scan2Key

The Scan2Key application can route input from a scanner port to keypad buffer, so
that all input from scanner will be treated as they are just input from keypad. With
this router, scanned data can be directly input into scanner port aware application,
like MS Pocket Word.
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Barcode Symbologies:
Set customization symbologies for each symbology including:

Symbology Enable
Disable

Send
Check
Digit

Max./Min
Length

Send
Leading

Digit
Other

Code 39 Yes Yes Yes Full ASCII
Send Start/Stop Character

I 2 of 5 Yes Yes Yes Send Start/Stop Character
Fix Length

S25/Toshiba Yes Yes Yes Fix Length

Code 32 Yes Send Leading Code
Send Trailing Code

Telpen Yes Character Set

EAN 128 Yes

Code 128 Yes Yes

MSI/Plessy Yes Yes Yes Check Digit Module

Code 93 Yes Yes

Code 11 Yes Yes Yes One/Two Check Digit

CodaBar Yes Yes Yes Send Start/Stop Character
CLSI Format On

Label Code Yes Yes

UPC-A Yes Yes Yes

UPC-E Yes Yes Yes Zero Expansion On
Enable NSC

EAN 13 Yes Yes Yes Enable Bookland

EAN 8 Yes Yes Yes

Delta Code Yes Yes Calculate Check Digit

Supplement
Supplement 2
Supplement 5
Space Separator Inserted
If Present, Transmit / Presence Required
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Appendix A

Technical Specifications

CPU/Memory

Input/Output

Audio Output A piezoelectric buzzer with software controlled volume

Contrast adjustable by software hotkey

Display 240 x 320 pixels portrait type, 65535 Color LCDwith touch
screen and Electroluminescent backlight.

Dual colors (green/red) for barcode good read indicationLED Indicator

SDRAM 64MB

Flash ROM 64MB Built-in (Flash Memory Manager included)

CPU Intel X-Scale 400MHz 32 CPU. Built-in real-time clock.

Input Devices Touch screen, stylus, keypad, full alphanumeric software
keyboard, magnetic stripe reader, and bar code scanner

Keypad 19 physical keys with backlight including cursor key, nu-
meric keypad, alpha keypad,TAB, ESC, FUNC, brightness
and contrast controls

Scan Engine
Light Source: Visible Laser Dicode(VLD) 650nm.

Scan Rate: 39+Scan/Sec
Scan angle: +53° from normal
Min. print contrast: 25% absolute dark/light reflectanceat 650nm
Power Consumption: 65mA typicle@5V

Depth of Field: See next page
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Laser Typical Depth of Field

Interface Port

PCMCIA & CF PCMCIA Type II slot & CF Type I & Type II slot accept
memory, modem, and RF cards

RS232/USB/Charg-
ing Port

Power charging and EIA RS232C supports full duplex
asynchronous communications and baud rate up to 115.2K
bps.

IrDA Compliant to IrDA 1.2 (SIR). Baud rate up to 115.2K bps.

N e a r F a r
5 m i l 2 .0 in . ( 5 .1 c m ) 5 .2 in . ( 1 3 .2 c m )

7 .5 m il 1 .7 in . ( 4 .3 c m ) 8 .0 in . ( 2 0 .3 c m )

1 0 m il 1 .8 in . ( 4 .6 c m ) 1 0 in . (2 5 .4 c m )

1 0 0 % U P C 1 .9 in . ( 4 .8 c m ) 1 3 in . (3 3 c m )

2 0 m i l * 2 0 in . (5 0 .8 c m )

4 0 m i l * 2 5 in . (6 3 .5 c m )

5 5 m i l * 3 0 in . (7 6 .2 c m )

* D e p e n d e n t u p o n s y m b o l w id th

DecodeZone
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OS and Software Programming Tools

Power

Power Management Power consumption indicated on status bar

Backup Battery 1 rechargeable 3.7V, 120mAH Li-ion Polymer battery
cell for data backup

Power Options
(Battery pack can be recharged 500 cycles or
more)

External AC/DC adapter @12VDC/2A with regulator

Lithium-Ion @7.4V, 1850mAH Main Battery Pack

Standby mode: 45mA for sytem only without
backlight.
Suspend mode: 2mA for system only

Power Consumption Lithium-Ion battery: At 8V, room temperature.

Battery Charge 3 hours with external AC/DC adapter
3 hours with docking station

Barcode/Symbology

Symbology Codabar
Code 11
Code 32
Code 39
Code 39 Full ASCII
Code 93
Code 128
Delta Code
EAN-8, 13

EAN128
Interleaved 2 of 5
Label Code
MSI/Plessy
Standard 2 of 5
Toshiba
Telpen
Toshiba
UPC-A, E

Development LanguageMicrosoft Embedded Visual Tool for VB and VC pro-
gramming

OS Microsoft Windows CE5.0 Professional Plus
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Pin Assignment of Charge
and Communication Port

Mechanical and Environmental

Shock Multiple 4.0’ (1.2m) drops to concrete

5% to 95% RH non-condensingHumidity

Weight 15.59 oz. (442g) with battery pack

1.70” (4.33cm)Depth:
Width: 3.49” (8.76cm)

Dimensions 7.28” (18.5cm)Length:

Storage: -20°C to 60°C
Temperature Operation: -5°C to 50°C

Docking Station

Quick charging typically takes 3 hours

AC/DC adapter @ 12 VDC/2A with regulator

Power Input 16 pin connector for charging and communication pads to main
unit

Interface 1 EIA RS232C IDC type connector via PC/computer, 1 USB port

IP Rating IP 54

P in A ss ig nm ent Descrip tion

1 DCD

2 RX D Receive Data

3 T XD S end Data

4 DTR Data T ransm it Ready

5 S G S ig nal Ground

6 DS R Data S et Ready

7 RT S Request to Send

8 CT S Clear to Send

9 RI R ing Indicator

10 US B 5V US B 5V

11 12V 12V Input

12 NC

13 NC

14 G DN G round

15 UDC USB Differentia l Data Signal H igh Side 

16 /UDC US B Differentia l D ata Sig nal Low S ide
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Update and Upgrade OS

Appendix B

Update OS via Compact Flash (ATA card)

In order to upgrade or re-install the PA962 OS via Com-
pact Flash, you will require the NK.bin file (available from
Unitech Technical Support):

Note: File name must be “NK.bin” – do not rename it.
CAUTION: Users files will be erased!

Press OK.5.

Run \Windows\BootMode.exe from PA962 by tapping
My Computer -> Windows -> double tapping
“BootMode” .

4.

Plug the power adapter into the PA962.3.

Insert the Compact Flash Card into the PA962.2.

Copy file “NK.bin” from the PC to the root directory of
the Compact Flash card.

1.

The PA960 will display the following screen:6.

Insert CompactFlash
chip into PC Card
Adapter

PA960 BootLoader Ver 1.11
———————————————————-
PA960 Boot Loader Option
(1) Ethernet Image Update
(2) OS Image Update
(3) Boot Loader Update
(4) Serial Port Image Update
(5) Jump to WinCE
(6) Flash Erase
———————————————————
Choice:
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After the OS is successfully updated, the PA962 will automatically cold-start with
the new OS.

Press the ‘2’ key to select “OS Image Update”. FlashRom’s content will be
erased and the new OS will be written to FlashRom. Then you will see the
system will automaticlly run the following steps.:

7.

(1). Image goint to Flash
(2). Erasing Flash
(3). New programming Flash
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Appendix C

Troubleshooting Guide

Problem Solution
Battery needs recharging or replacement.
Ensure that battery is installed correctly.
Adjust " Power Properties"
Battery needs recharging.
Adjust " Power Properties" - especially if peripherals are used.
Adjust backlight of LCD or Keypad.
Replace battery pack if old(battery can be recharged approximately
500 cylces.)

"Low Backup Battery" message Charge terminal for 16 hours.
Make sure terminal is powered on.
Adjust screen brightness.
Calibrate touch screen.
Perform a warm boot - WARNING - Unsaved data will be lost.
Perform a cold boot - WARNING - Terminal will be reset to default
settings and data will be lost.
Make sure scanning application is loaded and operational.
Run " Scanner Setting" program to modify barcode read setting.
Bar code might be distorted and should be replaced.
Battery needs recharging or replacement.
If terminal is processing data, attach charging cable to ensure the
battery isn't depleted.
If terminal is connected to AC power, disconnect.
Perform a warm boot - WARNING - Unsaved data will be lost.
Perform a cold boot - WARNING - Terminal will be reset to default
settings and data will be lost.

Terminal does not power on.

Bar code not read.

Terminal will not shut off.

Terminal either dow not respond,
or responds inaccurately to touch
screen input.

Screen is blank

Battery life is short

Terminal shuts itself down.
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FCC Statement
This is a FCC Part 15 Class B product. In a domestic environment this product
may cause radio interference, in which case the user may be required to take
adequate measures.

European Conformity Statement
Declaration of Conformity with Regard to the R&TTE 1999/5/EC and EMC 89/336/
EEC directives.

This Class B Digital apparatus meets all requirements of the Canadian
Interferance-Causing Equipment Regulations.
Cet appareil numerique de la classe B respecte les exigences du Reglement sur
le material broilleur du Canada.
The device is certified to the requirements of RSS-139-1 for 2.4 GHz spread
spectrum devices.

Canadian Compliance Statement

Laser Information
The Unitech PA960 series is certified in the U.S. to conform to the requirements of DHHS/
CDRH 21CFR Subchapter J and to the requirements of IEC 825-1. Class II and Class 2
products are not considered to be hazardous.  The PA960 series contains internally a
Visible Laser Diode (VLD) whose emissions do not exceed the maximum limits as set forth
in the above regulations. The scanner is designed so that there is no human access to
harmful laser light during normal operation, user maintenance or during prescribed service
operations.

The laser safety warning label required by the DHHS/IEC for the PA960 series’s optional
laser scanner module is located on the memory compartment cover, on the back of the unit.

CAUTION - Use of controls or adjustments or performance of procedures other than those
specified herein may result in hazardous laser light. Use of optical instruments with the
scanner will increase eye hazard. Optical instruments include binolulars, microscopes, and
magnifying glasses. This does not include eye glasses worn by the user.



Federal Communication Commission Interference Statement 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 

Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection against harmful 

interference in a residential installation.  This equipment generates, uses and can radiate radio frequency 

energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 

radio communications.  However, there is no guarantee that interference will not occur in a particular 

installation.  If this equipment does cause harmful interference to radio or television reception, which can 

be determined by turning the equipment off and on, the user is encouraged to try to correct the interference 

by one of the following measures: 

z Reorient or relocate the receiving antenna. 

z Increase the separation between the equipment and receiver. 

z Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 

z Consult the dealer or an experienced radio/TV technician for help. 

 

FCC Caution: Any changes or modifications not expressly approved by the party responsible for 

compliance could void the user's authority to operate this equipment. 

 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 

This device may not cause harmful interference, and (2) this device must accept any interference received, 

including interference that may cause undesired operation. 

 

 FCC Radiation Exposure Statement: This equipment complies with FCC radiation exposure limits set forth for an 

uncontrolled environment. This equipment should be installed and operated with minimum distance 20cm between

the radiator & your body.

 


